Support Notes

Customising Forms

This support notes are suitable for:

« MYOB Accounting
« MYOB Premier
« MYOB Premier Plus

Introduction

One great feature of MYOB software is that it allows you to customise the look of your invoices,
purchase orders, cheques and mailing labels.

What are MYOB Forms?
MYOB Forms are used by MYOB for printing:
« Cheques and cheque stubs - Spend Money, Pay Bills and Paycheques
+ Sales - Statements, Invoices and Receipts
. Bills
« Mailing Labels

MYOB's forms are fully customisable and are saved as individual files that are separate to your
company file. They are stored in the MYOB\Forms folder and can be backed up with your company
file. For information on backing up your MYOB data, please refer to support notes on backing up
and restoring.

How do | access MYOB's forms?
To access the various MYOB forms:

1. Click Setup, followed by Customised Forms.
2. Select the desired Layout and Form to Customise options.

3. Click Customise.

Alternatively, if you select an option from one of the command centres such as Print Cheques in
the Banking command centre, you can click Customise in the Forms Selection window.
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How do | set a form's page size and other properties?

After opening the form to be customised, click the Form Properties Tool which is located on the
form's tool palette - please refer to the section titled What tools are available for customising MYOB
Forms? for the location of the Form Properties Tool.

The window below shows the Form Properties dialogue box. Notice there are two tabs titled
Layout and Options.

2 Form Properties - Item 5ales E|

Layout ] [ Options ]

MHumber of Sales per Page: |1
Paper: |.-i'-.4 Letter: 21.001 = 29.7 cm. |

Marging——— Form Size

I%L 0.000) crn. ::3 29.700/ cri.
=3 0000 cm | | 3 | 21001 cm

Bow
Help F1

Layout tab
Please Note:
« In this section, 'Form' refers to the area of the page that is used for printing.

# of (Sales, Purchases, Statements, Slips, Receipts or Cheques) per Page - Specify the
number of documents (sales forms, purchases forms, statements or cheques, depending upon the
type of form you're printing) that you wish to print an a single page.

This field does not appear when you are printing mailing labels.
Paper - Select the size of the paper loaded in your printer.

Margins (from top) - This field allows you to enter coordinates to position the Form at a specific
location on the paper. Enter the number of centimetres that you want the form to print from the
top of the page.
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Margins (from left) - This field allows you to enter coordinates to position the Form at a specific
location on the paper. Enter the number of centimetres that you want the form to print from the
left side of the page.

Form Size (height) - This field allows you to enter the vertical size of the Form.

Form Size (width) - This field allows you to enter the horizontal size of the Form.

Options tab

The window below shows the Form Properties Options tab.

& Form Properties - ltem Sales

Layout l Options ]

Gnid Options — Sample Dizplay
 Showgid N |:|25.:n-. ................... ﬂ
[ Snap to Grd
Mathing Selected

Background Options

|nzert Backaground | Dizplay: | Top -

7

5w Cancel | 1]
Help F1

Grid Options

« Check Show Grid to make the alignment grid appear in the Form layout area of the
Customise window.

« Check Snap to Grid if you want the top and left edges of every field to align automatically
with the nearest grid lines.

-+ Grid Size - Select a measurement from the drop-down menu to adjust the size of the
squares in the alignment grid.

Background Options

+ Click Insert Background to insert a graphic file in the background of your form.

1470 Page 3 of 12



- Display - Use the options in the Display list to determine how your background graphic
will appear on the form.

- Sample Display area - A sample of your current grid and background settings appears
here.

For detailed information on applying graphics to forms, please refer to our support note titled
Graphics in Forms.

How do I reposition a form's elements?

Your form's elements (fields, lines, pictures, etc.) can be quickly repositioned by using standard
'drag and drop' principals.

Moving a single element:

1. Place your cursor on the element to be moved.
2. Hold down your left mouse button and 'drag' the element to the desired position.

3. Release the mouse button to 'drop' the element.
Please note:

- If you are moving a field and the Snap to Grid option is selected (refer to Grid
Options above), when you release your mouse button the field will automatically align with
the nearest grid line. This is a great tool for quickly aligning all the fields in a form.

Moving a group of elements

1. Hold down the <shift> key on your keyboard.

2. Click once on each field or element to be moved (releasing the mouse button after selecting
each element).

3. After selecting the last element of the group, release both the mouse button and the <shift>
key.

4. Place your cursor over one of the selected elements then hold down your left mouse button.
While holding your mouse button, drag the group of elements to the desired position.

5. Deselect the group of elements by clicking on a blank portion of the form.
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How do | format the fields on a form?

Formatting your MYOB forms is easy, as the different Form types all share the same field types and
formatting tools.

The window below shows a standard MYOB Invoice Form.

(& MYOB Premier - [Customise ltem Sales - MY OB Premier's Plain Paper Invoice]
E] File Edit Lists Command Centres Setup  Reports  wWindow  Help

[Company Name]
[Company Address]

ROC #[REOC #H

Form fields
MYOB forms mainly consist of Data Fields and Text Boxes.

- Data Fields - are easily recognised by their faint borders and the brackets surrounding their
name. Although a data field's properties can be changed, the printed data is program
generated. For example, referring to the window above, the [Company Name] Data
Field prints the company name entered in your company file's setup.

- Text Box - These fields appear without a border and are generally used for headings.
Additional Text Fields can be created and the text within them can be changed.

Double clicking on the Data Fields and Text Boxes will cause their Field Properties window to
be displayed. The window below shows the Field Properties for R.O.C. number text field.
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[E Field Properties

Layout ] [ Borders ]

Test:|R.OC #:
Figld Lozation——— Field Size
||E 4 509 cr. Ij; 0.445 cm.
—>IE 2540 cri. Sk 2794 cm.

Text Format Background Colour |

7

L
Help F1

Cancel |

Please Note:

« Text to be printed on the form is entered in the Text field.

- The Data Fields and Text Boxes share the same formatting options. Notice that the
window has two tabs - Layout and Borders. The options and fields listed under each tab
are outlined below.

Layout tab

- Text (field not available for Data Fields) - Enter or change the text for the field you
selected in the Customise window.

- Field Location (from top) - Use this field to enter coordinates that will position the field at a
specific location on the form. Enter the number of centimetres from the top of the page
where you want the field to print.

+ Field Location (from left) - Use this field to enter coordinates that will position the field at a
specific location on the form. Enter the number of centimetres from the left-hand side of the

page where you want the field to print.

- Field Size (height) - Use this field to specify the vertical size of this field. Enter the height in
centimetres.

- Field Size (width) - Use this field to specify the horizontal size of this field. Enter the width
in centimetres.
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- Text Format button - Click this button to launch the text formatting window, where you
can determine the field's text characteristics.

- Background Colour - Click this button to select a background colour for the field. You can
choose a background colour from the palette provided, or you can define and use custom
colours.

Borders

- Border Layout - Mark the Left, Top, Right or Bottom boxes to create borders for the
field. If you want the border to have rounded edges, mark Rounded Edges.

- Border Colour - Click this button to select a colour for the border of this field.
«  Border Width - Select a width for the lines in the border.

- Preview - This area displays a preview of how the text or data will be printed.

How can | resize a field?

Click once on the field to be resized (releasing your mouse button). Select one of the 8 border
handles then drag the field's border to resize the field.

The window below shows a Data Field selected for resizing. Notice the 8 border handles (the
small black dots spaced out around the field's border).

(& MYOB Premier - [Customise ltem Sales - MYOB Premier’s Plain Paper, Invoice]
E] File Edit Lisks Command Centres Setup  Reporks  Window  Help

Ecompany Mame] . 1
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What tools are available for customising MYOB forms?

The window below shows the tool palette that is located at the top of the Customise
Form window. The tool palette provides a range of formatting tools for adding effects and
additional objects to your form.

(& MYOB Premier - [Customise ltem Sales - MYOB Premier’s Plain Paper, Invoice]
E File Edit Lists Command Centres Setup  Reporks  Mindow  Help

The tool palette options are as follows:

8  |Add Data Fields - Clicking this button will display a list of Data Fields that can be added
to the Form. To add a field from the list, simply place a check mark in the Selected field
against the Data Field(s) you want included on the Form and click OK.

T  |Text Box Tool - This button allows you to create additional Text Boxes. To create a new
Text Box, click the Text Box Tool then click once on a blank portion of the Form.
Double click the new Text Box to set the field's properties and enter the desired Text.

B |Picture Tool - Pictures are commonly used for adding company logos. Click the Picture
Tool then click the Form where the picture is to appear. A picture frame will now appear
on your Form. Double click the field to display its properties. For detailed information on
adding pictures to your forms, please refer to our support note titled Graphics in Forms.

2 ||IRectangle Tool - Rectangles provide a convenient method of placing a border around the
various Form fields. Click the Rectangle Tool then place your cursor on the Form. Hold
down your left mouse button and draw the rectangle.

N |[Line Tool - Creates horizontal and vertical lines. Click the Line Tool then place your cursor
in the Form. Hold down your left mouse button and draw the line.

Undo - Click this button to return a field to the position it was moved from.

%@ |Send To Back - Form fields can be placed on top of each other. If one field obscures
another, select the object on top then click the Send To Back tool.

o Bring To Front - Opposite to the above; brings obscured fields to the front.

Font Tool - Provides a quick method of formatting a field's fonts. Select the field then
click the Font Tool to display the Font window.

To simultaneously set the font properties for a group of fields, hold down the <shift> key
while clicking on the fields to be formatted. With all the group of fields selected, click the
Font Tool to set their font properties.

To quickly set the fonts for all fields on all Forms, click the File menu, then select Default
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Fonts, followed by Forms. Set the font properties then click OK.

Form Properties Tool - See section above titled How do I set a form's page size and other
form properties?.

B

Print Preview - Allows you to view the Form as it will be printed.

How do | print using a customised form?

Cheques

1.

Click Banking, followed by Print Cheques.

2. Click the Selected Form for Cheque field drop down arrow, highlight the desired from then

click Use Form.

3. Click OK.

Sales

Statements

1.

Click Sales, followed by Print Statements.
Click the Statement Type field drop down arrow and select the desired Statement Type.

Click the Selected Form for Statement field drop down arrow, highlight the desired form
then click Use Form.

Click OK.

Invoices

1.

1470

Click Sales, followed by Print Invoices.
Click the Form Layout field drop down arrow and select the desired Invoice type.

Click the Selected Form for Invoice field drop down arrow, highlight the desired form
then click Use Form.

Click OK.
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Receipts

1. Click Sales, followed by Print Receipts.

2. Click the Selected Form for Receipt field drop down arrow, highlight the desired form
the click Use Form.

3. Click OK.

Bills

1. Click Purchases, followed by Print Purchase Orders.
2. Click the Form Layout field drop down arrow and select the desired Bill type.

3. Click the Selected Form for Purchase field drop down arrow. highlight the desired form
then click Use Form.

4. Click OK.

Mailing Labels

1. Click Card File, followed by Print Mailing Labels.

2. Click the Selected Form for Mailing Label field drop down arrow, highlight the desired
from then click Use Form.

3. Click OK.

How do I save a customised form?

Referring to the Customise Form window above, there are two options for saving a form.
Save Form

Click Save Form to save a form using the existing form name.

Save Form As

Use this option to save your formatting changes to a new form. After customising a form, click
Save Form As, enter the Form File Name and Description, then click OK.
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Frequently asked questions
How can | delete a field?

1. Click the field or element to be deleted

2. Go to the Edit menu and select Clear.

Deleted data type fields can be re-created by clicking on the Add Data Fields button on the tool
palette.

I can see a field on the form but when I click it, something else is displayed.

Click on the area where the field is placed then click the Send To Back toolbar button. You
should now be able to select the other field.

My Invoices and Bills are printing with the wrong tax status.

The tax status of Invoices and Bills is determined by the form being used. For example, your
Invoices are entered as tax inclusive but they are printing as tax exclusive.

Open your Bill or Invoice form and identify the affected price or amount data fields. You will
notice that each price field has a prefix of either 'Inc' or 'Ex'. The 'Ex' prefix indicates that the field is
tax exclusive and 'Inc' indicated that the field is tax inclusive.

To change the tax status of a form:

1. Delete the price field(s).

2. Click the Add Data Fields button on the form's toolbar.

3. Select the price and amount fields that will print the amounts with the correct tax status.
4. Click OK and position the field.

5. Click Save Form As then enter the Form File Name and Description.

I receive a paper size error when printing my forms.

The window below shows an alert that is displayed if the form's paper size is different to the default
paper size for your printer.
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=
B MYOB Premier

The paper zize you have indicated for printing cheques iz
L] IS Letter.

The paper zize chozen in Print Setup appears to be A4
Letter,

An appropriate choice in Print Setup would be S Letter: 21.59 =
27.94 cm., partrait onentation.

This is easily overcome by ensuring the form's Paper size, MYOB's Print Setup and your printer
driver's default paper size are all set to the size of the paper loaded in your printer.

- Form's Paper size - to set the form's Paper size, please refer to the section titled How do |
set a form's page size and other properties?

- MYOB's Print Setup - open your company file, go to the File menu and select Print
Setup (Macintosh - Page Setup). Click the Paper Size field drop down arrow then select
the paper size of the paper that is loaded in your printer.

« Printer's setup - if you are unsure how to check or change your printer's setup, please check
the Help function of your operating system or your printer's documentation.
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